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ABSTRACT

The automotive water cooling system is a crucial component of an engine, responsible for
maintaining optimal operating temperatures and preventing overheating. This project aims
to design an efficient and reliable water cooling system for automotive engines. The
system comprises various components, Arduino, water pump, Temperature sensor,
coolant, hoses, and controls. A water pump circulates the coolant, ensuring a consistent
flow between the engine and the radiator. A thermostat regulates the coolant flow, opening
and closing based on the engine's temperature to maintain it within the desired range.A
mixture of water and antifreeze serves as the coolant, absorbing heat from the engine.
Electric cooling fans enhance airflow through the radiator when natural airflow is
insufficient, controlled by temperature sensors or the engine control unit (ECU). Hoses
and pipes connect the different components, facilitating the closed-loop flow of coolant.An
expansion tank provides room for coolant expansion and contraction, preventing air
pockets and maintaining a constant coolant supply.Sensors and controls monitor engine
temperature, coolant level, and other parameters, allowing the ECU to optimize engine
performance by adjusting water pump operation. EngineJust Sample Box used a Light.

Automatic Cooling System and Auto Cutoff depend on Temperature

Keyword: Automotive water Cooling System Engine, Temperature sensor etc.
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CHAPTER 1
INTRODUCTION

1.1 Introduction

The purpose of cooling system f is to keep the engine atits most efficient operating
temperature as high as2200C may be reached during the engine operation.Although the
cylinder wall, cylinder head, valves, pistonrings and the pistons absorbs some of this heat.
Eventhough the average temperature in the internal vicinity ofthe cylinders stands at about
14000C. If this heat is notdissipated, the surface of the combustion chamber willoecome
red hot, thewall will burn and wrap, and variousparts of the engine will expand
excessively resulting inseizure of piston and bearings. Cylinder walltemperature must not
go as high as 2500C. Temperaturehigher than this causes the lubricating-oil film to
breakdown and loose its lubricating properties. So the coolingsystem is preferred to cools
the engine rapidly when it ishotEmbedded devices can be found in many different
applications and industries, example, from consumer appliances like the CD alarm clock
that wakes us in the morning to the GPS navigation systems in our cars, and Cell phones

and PDAs that keeps us connected.

A number of embedded micro components in devices are also growing. A luxury car today
has more than 150 embedded micro-controllers and microprocessors in all sorts of
applications ranging from engine control mechanism to entertainment devices. The
automotive industry is an important pillar of the world economy. Advanced automation
supports manufacturing companies in there strive for increased efficiency and quality
optimization. Further the biggest trends in automotive engineering are improving engine
efficiency and fuel economy. Some companies are developing optimized and most
advanced diesel engines to draw waste heat out of the engine in order to allow the engine
to operate efficiently. Kenneth. J. Kelly described two approaches of engine cooling
system where it describes about hybrid electric power inverters with separate cooling loop
with water ethylene glycol coolant at 70°C, the cost of cooling system is reduced by using
silicon-carbide switches [1]. Jianwen Shao and his co workers described some
experimentaltechniques for automotive applications, such as motor rotation detection,
current sensing with brushless DC motor, which are currently using in power steering,

engine cooling fan, fuel/water pump, air conditioning compressor etc [2].



The theoretical model developed for analyzing the heat transfer of automotive cooling
system with modular structure links with various cooling system sub models [3]. It was
also focused to require much higher performance owing to the improved power output of
engines. Engine thermal management system functionality was described with smart
thermostat values and variable speed electric pumps and fans [4], [5]. All the above papers
described on automotive applications stressing on engine cooling system. But some of
them describe on thermal management systems, Motor speed. Efficiency of motor output
and so on. But the papers dealing with advanced 32-bit ARM microprocessor are less.
ARM is the industry leading RISC processor architecture in the world, dominant in the
mobile industry and medical, industrial applications. For future projects designers are
looking for the usage of 32-bit microprocessors.It is typically concentrates on applications
of vehicle cooling system based on ARM Cortex M3 (LPC1768). PT100 temperature
sensor is used to control the heat engine which in turn reduces the fuel wastage. Our main
aim is to reduce the cooling time with low cost, occupying less space with simple
hardware and software algorithm. Thermal energy flows are an important part of a
vehicles energy balance. Even in the most advanced engines the vehicle drive uses barely
one third of the fuel energy. The task of engine cooling is to draw waste heat out of the
engine in order to allow the engine to operate efficiently.

Companies are developing optimized cooling systems by linking them with ECMs,
intercoolers and exhaust gas recirculation coolers. On the other hand company engineers
are developing thermal management system products based on applied waste heat
recovery, heat exchange and other technologies. A typical cooling system consists of an
engine water jacket, thermostat, water pump, radiator, cooling fan, hoses, heater core, oil
cooler and overflow, or expansion tank. There are two types of cooling systems: air and
water cooling. As the name suggests, air cooling systems involve fans which blow air over
the engine block. Heat absorbed by the engine oil is dispersed by an air-cooled oil cooler
mounted at a suitable position in the air stream. The noise emission level and the
inefficiency in maintaining consistent engine temperatures are considered to
bedisadvantages compared to liquid-cooled engines. Today, air cooling is mainly used for

motorcycle engines and in special applications.



The oil cooler is a heat exchanger that uses an air-cooling system to maintain the
optimized oil temperature of vehicle oils, including engine oil and automatic transmission
oil. Water-cooled engines, on the other hand, have passages for the coolant to pass through
the engine, absorbing the heat generated so it can be released through the radiator. The
cooled fluid is recirculated around the engine while running. Water cooling has become
the standard in both passenger cars and heavy-duty vehicles. Instead of pure water,
coolants are now a mixture of water (drinking quality), anti-freeze and various corrosion
inhibitors. An antifreeze concentration raises the coolant mixture boiling point to allow
operating temperatures at a pressure bar in passenger cars. ‘Thermal management’ means
products such as radiators, charge-air coolers and oil coolers that use a medium (air or
liquid) to cool the heat that is produced by a vehicle engine. As the primary component of
the cooling module, the radiator includes the radiator core, the coolant tank and all the
connections. The radiator core itself consists of a finned tube system with tube headers and
side supports. The cores of the coolant radiators in passenger cars are almost exclusively
made of aluminum. Aluminum radiators are also being used to an increasing extent in a
range of commercial vehicles worldwide. Figure 1 shows the example of engine cooling

system

1.2 Objectives

The objectives of this project are:

e Todesign and construct a Project using Automotive Water Cooling System
of Engine.

e Automotive Water Cooling Engine Box used a Light and Automatic Cooling
System and Auto Cutoff depend on Temperature.

e To take necessary notes from the project for future improvements.

1.3 Thesis Overview

This Project is organized as follows:

Chapter 1 Introduction: The first chapter contains the statement of the introduction, our
background study for the project, the problem statement, the objectives of the study, and

the project outline.



Chapter 2 Literature Review: Chapter two contains our introduction and literature review

part.

Chapter 3 Hardware and Software Analysis: Chapter three describes the theoretical model.
Here we mainly discuss the proposed system Hardware and software development of our

project etc.

Chapter 4 Methodology: Chapter three describes the theoretical model. Here we mainly
discuss the proposed system architecture in detail with having a block diagram, circuit

diagram, structural diagram, project working principle, complete project image, etc.

Chapter 5 Result and Discussion: Chapter four deals with the result and discussion and

discuss our project's advantages and application.

Chapter 6 Conclusion: Chapter five is all about our project conclusion and future scope.



CHAPTER 2
LITERATURE REVIEW

2.1 Literature Review

Copper and brass were used in making radiator parts as they were good conductors of heat
but were costly both as materials and for manufacturing. Ford company in 1983 tried to
find different alternative material which will be used in radiators. After several
experiments aluminium was selected for making radiator parts. The reason behindit was
that it was lighter in weight, lower in cost, reliable and durable toits copper and brass
counter parts. It was selected where cooling requirements were moderate. It was used in
making tubes, fins and header of the radiator. 3003Al for tubes by extrusion process, hard
3003Alfor fins in flat plate design, 3005Al for header of the radiator. Fin pitch was kept

from 1.1mmto2.2mm.

The air side interface of this radiator joint was sealed with one part epoxy to prevent
seepage and strengthen the header. The tank of the radiator was joint to the core by
sandwiching a nitrile rubber gasket between header and tank. After the whole assembly,
the radiator was tested and its calorimeter performance, durability, corrosion resistance
and qualification with respect to vehicle was noted down. It was concluded from these
experiments aluminium performed better inall the tests and was used inall automobiles
manufactured by ford from that time.After several years to the fulfill the demand of a

corrosion resistant radiator.

For making in good corrosion resistant radiator tube the properties such ashigh corrosion
resistant and high resistance to stress corrosion cracking due to solder flux should be
satisfied. After testing different materials ‘CACTUS CB203’ was selected. Three main
tests were performed onall the materials they were: - Salt Spray Test: -. According to
ASTM-85 this test was conducted. In salt spray test mixture of salt and water is sprayed
onthe radiator tubes in order to examine the corrosion resistance on the radiator tubes.
Under Microscope this test was conducted and researcher found out that maximum
dezincification of brass CACTUS CB203 is about 1/10thof that Phosphorous and
Comparable arsenic brass.Corrosion Test- Corrosion test was performed on the radiator
tubes in which specimen were immersed in the solution and the results were obtained that

5



1/5thof brass and phosphorus stress. Corrosion Cracking Test: - Stress Corrosion is
performed on CACTUS CB203 brass. In which slight corrosion was observed on the

material in the form of graph.

In year 1992an experiment was performed to increase the thermal efficiency of radiator. It
was done by using a converge shape at the starting of coolant flow whichreduce the
pressure of the tube in one size of tube made the coolant flow in smaller quantity from
each tube. This helped the coolant to cool at faster rate increasing the thermal efficiency of
tube [2].

After a decade it was discovered that the airflow around the radiator had a huge part in
cooling the system and the system was not optimize to use the air efficiently. Different
tests were done on a vehicle with a radiator installed init and all different measures that
affects in cooling of the system were taken into account. Tests were done considering
aerodynamic drag that acts on the vehicle and how it would influence the cooling airflow.
Also, other test was done considering crosswind flowing through the vehicle when itsin
yaw or lifted. Different thermal rejection methods were tested to achieve a radiator which

was thermally balanced and was efficient throughout the test [3].

The high thermal conductivity graphite was less in weight and has density between 0.2to
0.6m/cm™3 & bulk thermal conductivity is 187w/m"2.k due to the bulk thermal
conductivity of graphite it will increase the cooling which will result in reduction of tubes
required for cooling the system. Using graphite in the radiator assembly will reduce the
overall weight, cost & volume of the radiator thereby improving fuel efficiency of the
vehicle [4].

The radiators required a higher heat flux. The carbon foam has higher heat transfer
efficiency & better heat dissipation. Using carbon foam the material fins and tube had
given great result in efficiency of cooling system. But the problem of carbon foam
material was that it was not giving the required strength for the radiator and also there
were bonding issue. To overcome this, carbon foam was coated with 2 different material
made of Sic and metallization was done over it. This resulted increase in the strength and
bonding of carbon foam material by 430%in which Sic coating gave increase 100% and

metallization layer gave 330% improvement [5].



The era of 2007 normal radiators were using parallel tubes which had aluminium fins
attached to them. They were not giving the heat transfer coefficient to improve cooling.
They designed some different fins which were made upof carbon foam which had porosity
of 70% thickness of 0.762mm and heat transfer coefficient 1000 w/m”2 k. This resulted in

better heat dissipation which increased the cooling efficiency of radiator [6].

After several years an experiment was done which tested the radiator design with practical
scenarios. The heat transfer rate of radiator was cross verified, internal flow of water
through radiator tubes whichwas depended on area of tube, velocity of water flowing from
the tubes,Reynold’s number of water. Also, with these external flow of air over tubes and
fins of the radiator, air Reynold’s number, fin’s dimension and its efficiency and
effectiveness by NTU method [7].

In the year 2009 using the side podfor improving the efficiency of radiator an fsae team
used aerodynamic consideration in which they used converging and diverging roles. The
Design were tested on Ansys CFD Simulation. From the results they concluded that using
an aerodynamically shape side pod was directing the air on face of the radiator which

increased the cooling rate of the radiator and the issue of overheating was overcome [8].

After a year a new material was discovered as carbon foam it was tested for material of
fins. During research of the material it was discovered that it has extremely high thermal
conductivity and had an open cell structure which will helpto make a radiator efficient
from a huge margin. The researcher also found out that they can improve the rate of heat
dissipation through radiator by lowering the coolant inlet temperature and decreasing the
air side resistance. After all the testings they observed that carbon foam’s heat transfer
coefficient was 40% greater than aluminium and it was28% lighter in weight than

aluminum [9].

In year 2015 to reduce the size of radiator and also not come across overheating issues, the
inlet port of radiator was provided with sensor attach toit. Same sensor was attach in the
outlet port. Both sensor were connected to the ECU and were monitored continuously.
Also with these the coolant tank was brought closer to inlet port which made sure the flow
of water was continuous without any lag; by doing this the overheating of engine was

reduced by a huge margin. This resulted in reduction of the size of cooling system. The
7



cooling system overall weight was reduced by45% from its previous results. This not only
reduce weight of the vehicle but also power loss done by radiator that was generated by the

engine was reduced by huge margin. Also fuel efficiency was increased [10].

step method in which synthesis of nanofluid was done, other method was called two step
methods in which particles were directly mixed with base fluids. It was concluded that the
density, viscosity and thermal conductivity of nanofluid will increase with increase in

volume concentration of particles in fluid [11].

He also considers different ways and methods in different scenarios in which the first
approach was by theoretical and numerical. From this calculation the size of tube and
thickness of fin of radiator was determined. This calculation was then converted into a
CAD model and it was simulated on 1-D simulation software. From the results he found

out that overall radiator efficiency was improved [12].

In year 2016 the different assembly of tubes in the radiator were tested on software and
calculation basis different setups of tube were considered like parallel flow, cross flow, flat
tube, helical tube structure, dual pass flow in which they found out that parallel flow setup
was not providing better result in cooling the system but also the material required to build

the assembly was less hence overall cost was reduced [13].

2.2Methodology

Our used methodology for the project:

e Creating an idea for the design and construction of Automotive Water Cooling
System of Engine.And designing a block diagram & circuit diagram to know
which components we need to construct it.

e Collecting all the components and programming the micro-controller to control our
desired system.

e Setting up all the components in a PCB board & soldering. Then assembling all the
blocks in a board and finally running the system to check if it actually works or

not.



2.3TYPES OF COOLING SYSTEM

There are two types of cooling systems:
(i) Air cooling system and
(if) Water-cooling system.

AIR COOLING SYSTEM

In this type of cooling system, the heat, which is conducted to the outer parts of the
engine, is radiated and conducted away by the stream of air, which is obtained from the
atmosphere. In order to have efficient cooling by means of air, providing fins around the
cylinder and cylinder head increases the contact area. The fins are metallic ridges, which
are formed during the casting of the cylinder and cylinder head The amount of heat carried

off by the air-cooling depends upon the following factors:

() The total area of the fin surfaces
if) The velocity and amount of the cooling air and

(iti) The temperature of the fins and of the cooling air.

Air-cooling is mostly tractors of less horsepower, motorcycles, scooters, small cars and
small aircraft engines where the forward motion of the machine gives good velocity to
cool the engine. Air-cooling is also provided in some small industrial engines. In this
system, individual cylinders are generally employed to provide ample cooling area by

providing fins. A blower is used to provide air.

1. Its design of air-cooled engine is simple.

2. It is lighter in weight than water-cooled engines due to the absence of water jackets,
radiator, circulating pump and the weight of the cooling water.

3. It is cheaper to manufacture.

4. |t needs less care and maintenance.
This system of cooling is particularly advantageous where there are extreme climatic
conditions in the arctic or where there is scarcity of water as in deserts.

6. No risk of damage from frost, such as cracking of cylinder jackets or radiator

watertubes.



WATER COOLING SYSTEM

It serves two purposes in the working of an engine:

a) It takes away the excessive heat generated in the engine and saves it from over heating.
b) It keeps the engine at working temperature for efficient and economical working. This

cooling system has four types of systems:

(i) Direct or non-return system,

(if) Thermo-Syphone system,

(iii) Hopper system and

(iv) Pump/forced circulation system.

Though the present tractor has a forced circulation system, it is still worthwhile to get
acquainted with the other three systems. Non-Return Water Cooling System This is
suitable for large installations and where plenty of water is available. The water from a
storage tank is directly supplied to the engine cylinder. The hot water is not cooled for
reuse but simply discharges. The low H.P. engine, coupled with the irrigation pump is an
example. Thermo-Syphone Water Cooling System This system works on the principle that
hot water being lighter rises up and the cold water being heavier goes down. In this system
the radiator is placed at a higher level than the engine for the easy flow of water towards
the engine. Heat is conducted to the water jackets from where it is taken away due to
convection by the circulating water. As the water jacket becomes hot, it rises to the top of
the radiator. Cold water from the radiator takes the place of the rising hot water and in this
way a circulation of water is set up m the system. This helps in keeping the engine at

working temperature. Disadvantages of Thermo-Syphone System

1. Rate of circulation is too slow.
2. Circulation commences only when there is a marked difference in temperature.
3. Circulation stops as the level of water falls below the top of the delivery pipe of the

radiator. For these reasons this system has become obsolete and is no more in use.

Hopper Water Cooling System

This also works on the same principle as the thermo-syphone system. In this there is a
hopper on a jacket containing water, which surrounds the engine cylinder. In this system,
1



as soon as water starts boiling, it is replaced by cold water. An engine fitted with this

system cannot run for several hours without it being refilled with water.

Water Pump

This is a centrifugal type pump. It is centrally mounted at the front of the cylinder block
and is usually driven by means of a belt. This type of pump consists of the following parts:
(i) body or casing, (ii) impeller (rotor), (iii) shaft, (iv) bearings, or bush, (v) water pump
seal and (vi) pulley. The bottom of the radiator is connected to the suction side of the
pump. The power is transmitted to the pump spindle from a pulley mounted at the end of
the crankshaft. Seals of various designs are incorporated in the pump to prevent loss of
coolant from the system. Fan The fan is generally mounted on the water pump pulley,
although on some engines it is attached directly to the crankshaft. It serves two purposes in

the cooling system of a engine.

(@) It draws atmospheric air through the radiator and thus increases the efficiency of the
radiator in cooling hot water.

(b) It throws fresh air over the outer surface of the engine, which takes away the heat
conducted by the engine parts and thus increases the efficiency of the entire cooling

system.



CHAPTER 3
HARDWARE AND SOFTWARE ANALYSIS

3.1 Required instrument

Hardware
e Arduino Nano
e SMPS
e Temperature Sensor
e Pump Motor

e Relay

3.2Arduino Nano

Arduino is open-source electronics prototyping platform based on flexible, easy-to-use
hardware and software. It's intended for artists, designers, hobbyists, and anyone
interested in creating interactive objects or environments. Arduino can sense the
environment by receiving input from a variety of sensors and can affect its surroundings

by controlling Lights, motors, and other actuators.

v o TX )

T gy PON
!t L
A7 SV RSTGNDUIN

Figure 3.1: Arduino Nano

The micro-controller on the board is programmed using the Arduino programming
language (based on Wiring) and the Arduino development environment (based on

Processing). Arduino projects can be stand-alone or they can communicate with software
on running on a computer (e.g. Flash, Processing, MaxMSP).
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Figure 3.2: Arduino schematic diagram

Arduino Nano is a surface mount breadboard embedded version with integrated USB. It is
a smallest, complete, and breadboard friendly. It has everything that Diecimila /
Duemilanove has (electrically) with more analog input pins and onboard +5V AREF
jumper. Physically, it is missing power jack. The Nano is automatically sense and switch

to the higher potential source of power.

Nano’s got the breadboard-ability of the Boarduino and the Mini+USB with smaller
footprint than either, so users have more breadboard space. It’s got a pin layout that works
well with the Mini or the Basic Stamp (TX, RX, ATN, GND on one top, power and
ground on the other). This new version 3.0 comes with ATMEGA328 which offer more
programming and data memory space. It is two layers. That make it easier to hack and

more affordable.
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Figure 3.3: Section of Arduino Nano.



Specifications:

Features:

Micro-controller: Atmel ATmega328

Operating Voltage (logic level):5 V

Input Voltage (recommended):7-12 V

Input Voltage (limits):6-20 V

Digital 1/0 Pins: 14 (of which 6 provide PWM output)
Analog Input Pins: 8

DC Current per 1/O Pin: 40 mA

Flash Memory: 32 KB (of which 2KB used by boot loader)
SRAM :2KB

Automatic reset during program download
Power OK blue LED

Green (TX), red (RX) and orange (L) LED
Auto sensing/switching power input

Small mini-B USB for programming and serial monitor

Micro-controller 1IC ATmega328p:

Figure 3.4: Micro-controller 1C AT mega 328p.

The high-performance Microchip pico Power 8-bit AVR RISC-based micro-controller
combines 32KB ISP flash memory with read-while-write capabilities, 1024B EEPROM,
2KB SRAM, 23 general purpose 1/0 lines, 32 general purpose working registers, three

flexible timer/counters with compare modes, internal and external interrupts.

1.



3.3 Switch Mode Power Supply (SMPS):

A switched-mode power supply (switching-mode power supply, switch-mode power
supply, switched power supply, SMPS, or switcher) is an electronic power supply that
incorporates a switching regulator to convert electrical power efficiently. Like other
power supplies, an SMPS transfers power from a DC or AC source (often mains power) to
DC loads, such as a personal computer, while
converting voltage and current characteristics. Unlike a linear power supply, the pass
transistor of a switching-mode supply continually switches between low-dissipation, full-
on and full-off states, and spends very little time in the high dissipation transitions, which
minimizes wasted energy. A hypothetical ideal switched-mode power supply dissipates no
power. Voltage regulation is achieved by varying the ratio of on-to-off time (also known
asduty cycles). In contrast, a linear power supply regulates the output voltage by
continually dissipating power in the pass transistor. This higher power conversion
efficiency is an important advantage of a switched-mode power supply. Switched-mode
power supplies may also be substantiallysmaller and lighter than a linear supply due to the

smaller transformer size and weight.

Figure 3.5: SMPS

Switching regulators are used as replacements for linear regulators when higher
efficiency, smaller size or lighter weight are required. They are, however, more
complicated; their switching currents can cause electrical noise problems if not carefully

suppressed, and simple designs may have a poor power factor.
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Switched-mode power supplies are classified according to the type of input and output

voltages. The four major categories are:

e ACtoDC
e DCtoDC
e DCtoAC
e ACtoAC

A basic isolated AC to DC switched-mode power supply consists of:

e Input rectifier and filter

e Inverter consisting of switching devices such as MOSFETSs
e Transformer

e Output rectifier and filter

e Feedback and control circuit

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on
and off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET

or power transistors. The high-frequency voltage pulses from the inverter are fed to the

transformer primary winding, and the secondary AC output is rectified and smoothed to

produce the required DC voltages. A feedback circuit monitors the output voltage and

instructs the control circuit to adjust the duty cycle to maintain the output at the desired

level.
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Figure 3.6: SMPS Circuit
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Basic working concept of an SMPS

A switching regulator does the regulation in the SMPS. A series switching element turns
the current supply to a smoothing capacitor on and off. The voltage on the capacitor
controls the time the series element is turned. The continuous switching of the capacitor

maintains the voltage at the required level.

Design basics

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave
bridge rectifier. The rectified voltage is next applied to the power factor correction (PFC)
pre-regulator followed by the downstream DC-DC converter(s). Most computers and
small appliances use the International Electrotechnical Commission (IEC) style input
connector. As for output connectors and pinouts, except for some industries, such as PC
and compact PCI, in general, they are not standardized and are left up to the manufacturer.
There are different circuit configurations known as topologies, each having unique
characteristics, advantages and modes of operation, which determines how the input
power is transferred to the output. Most of the commonly used topologies such as flyback,
push-pull, half bridge and full bridge, consist of a transformer to provide isolation, voltage
scaling, and multiple output voltages. The non-isolated configurations do not have a

transformer and the power conversion is provided by the inductive energy transfer.

Advantages of switched-mode power supplies:

e Higher efficiency of 68% to 90%

e Regulated and reliable outputs regardless of variations in input supply voltage
e Small size and lighter

e Flexible technology

e High power density

e Disadvantages:

e Generates electromagnetic interference

e Complex circuit design

e Expensive compared to linear supplies
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Switched-mode power supplies are used to power a wide variety of equipment such as
computers, sensitive electronics, battery-operated devices and other equipment requiring

high efficiency.

Linear voltage IC regulators have been the basis of power supply designs for many years
as they are very good at supplying a continuous fixed voltage output. Linear voltage
regulators are generally much more efficient and easier to use than equivalent voltage
regulator circuits made from discrete components such a zener diode and a resistor, or

transistors and even op-amps.

The most popular linear and fixed output voltage regulator types are by far the 78...
positive output voltage series, and the 79... negative output voltage series. These two
types of complementary voltage regulators produce a precise and stable voltage output
ranging from about 5 volts up to about 24 volts for use in many electronic circuits.There is
a wide range of these three-terminal fixed voltage regulators available each with its own
built-in voltage regulation and current limiting circuits. This allows us to create a whole
host of different power supply rails and outputs, either single or dual supply, suitable for
most electronic circuits and applications. There are even variable voltage linear regulators
available as well providing an output voltage which is continually variable from just

above zero to a few volts below its maximum voltage output.

Switch Mode Power Supply
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Figure 3.7: SMPS Circuit Connection



Most d.c. power supplies comprise of a large and heavy step-down mains transformer,
diode rectification, either full-wave or half-wave, a filter circuit to remove any ripple
content from the rectified d.c. producing a suitably smooth d.c. voltage, and some form of
voltage regulator or stabiliser circuit, either linear or switching to ensure the correct
regulation of the power supplies output voltage under varying load conditions. Then a

typical d.c. power supply would look something like this:

Unregulated
——— Power Supply ——————————

A Fa Tl e
/ R

piinfEnfisf

a.c. mains d.c. output
Transformer Rectifier Filter Regulator

1
-u-l"::-h-
-

Figure 3.8: SMPS Supply Connection

These typical power supply designs contain a large mains transformer (which also provides
isolation between the input and output) and a dissipative series regulator circuit. The regulator
circuit could consist of a single zener diode or a three-terminal linear series regulator to produce
the required output voltage. The advantage of a linear regulator is that the power supply circuit
only needs an input capacitor, output capacitor and some feedback resistors to set the output
voltage.

3.4 Temperature Sensor
The DHT11 is a basic, ultra-low-cost digital temperature and humidity sensor. It uses a
capacitive humidity sensor and a thermistor to measure the surrounding air, and spits out a

digital signal on the data pin (no analog input pins needed). It’s fairly simple to use, but

requires careful timing to grab data.

DHT11 Specifications:

e Operating Voltage: 3.5V to 5.5V
e Operating current: 0.3mA (measuring) 60uA (standby)
e Output: Serial data
e Temperature Range: 0°C to 50°C
1!



e Humidity Range: 20% to 90%
e Resolution: Temperature and Humidity both are 16-bit
e Accuracy: £1°C and £1%

Figure 3.9: DHT11 Temperature Sensor

3.5 Pump Motor

This is a low cost, small size Submersible Pump Motor which can be operated from a 2.5
~ 6V power supply. It can take up to 120 litters per hour with very low current
consumption of 220mA. Just connect tube pipe to the motor outlet, submerge it in water
and power it. Make sure that the water level is always higher than the motor. Dry run may

damage the motor due to heating and it will also produce noise.

Figure 3.10: Pump Motor
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Feature:

Operating Current: 130 ~ 220mA
Flow Rate: 80 ~ 120 L/H

Maximum Lift: 40 ~ 110 mm
Continuous Working Life: 500 hours
Driving Mode: DC, Magnetic Driving
Material: Engineering Plastic

Outlet Outside Diameter: 7.5 mm

Outlet Inside Diameter: 5 mm

3.6 Relay

Arelay is an electrically operated switch. Many relays

an electromagnet to

mechanically operate a switch, but other operating principles are also used, such as solid-

state relays. Relays are used where it is necessary to control a circuit by a separate low-

power signal, or where several circuits must be controlled by one signal. The first relays

were used in long distance telegraph circuits as amplifiers: they repeated the signal

coming in from one circuit and re-transmitted it on another circuit. Relays were used

extensively in telephone exchanges and early computers to perform logical operations.

l__.NO
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Figure 3.11: Relay

A type of relay that can handle the high power required to directly control an electric

motor or other loads is called a contactor. Solid-state relays control power circuits with

no moving parts, instead using a semiconductor device to perform switching. Relays with

2.
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calibrated operating characteristics and sometimes multiple operating coils are used to
protect electrical circuits from overload or faults; in modern electric power systems these

functions are performed by digital instruments still called "protective relays".

Magnetic latching relays require one pulse of coil power to move their contacts in one
direction, and another, redirected pulse to move them back. Repeated pulses from the
same input have no effect. Magnetic latching relays are useful in applications where

interrupted power should not be able to transition the contacts.

Magnetic latching relays can have either single or dual coils. On a single coil device, the
relay will operate in one direction when power is applied with one polarity, and will reset
when the polarity is reversed. On a dual coil device, when polarized voltage is applied to
the reset coil the contacts will transition. AC controlled magnetic latch relays have single
coils that employ steering diodes to differentiate between operate and reset

commands.The relay module is the one in the figure below.

Figure 3.12: Relay Module.

This module has two channels (those blue cubes). There are other varieties with one, four

and eight channels.

Main’s voltage connections.

In relation to mains voltage, relays have 3 possible connections:


https://en.wikipedia.org/wiki/Protective_relay

Figure. 3.13: Main’s voltage connections.

COM: common pin

NO (Normally Open): there is no contact between the common pin and the normally
open pin. So, when you trigger the relay, it connects to the COM pin and supply is

provided to a load

NC (Normally Closed): there is contact between the common pin and the normally
closed pin. There is always connection between the COM and NC pins, even when the
relay is turned off. When you trigger the relay, the circuit is opened and there is no supply

provided to a load.
Pin wiring
The connections between the relay module and the Arduino are really simple:

GND: goes to ground

IN1: controls the first relay (it will be connected to an Arduino digital pin)

IN2: controls the second relay (it should be connected to an Arduino digital pin if you
are using this second relay. Otherwise, you don’t need to connect it)

VCC: goes to 5V



| LR EOW
JD—VCC VOC GND GND IN1 IN2 VCC

Figure 3.14: Main’s voltage connections.

3.7 5V Regulator IC

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage
outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC, a
member of 78xx series of fixed linear voltage regulators used to maintain such
fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx indicates
the output voltage it provides. 7805 IC provides +5 volts regulated power supply with
provisions to add a heat sink.

7805 IC Rating

® Input voltage range 7V- 35V
® Current rating Ic = 1A
® OQutput voltage range VMax=5.2V ,VMin=4.8V

2.



LM7805 PINOUT DIAGRAM

LM7805 1 —{LM7805}— 3
input | output
2
ground

Figure 3.15 : 5V Regulator IC

3.8 Arduino IDE

The digital micro-controller unit named as Arduino Nano can be programmed with the
Arduino software IDE. There is no any requirement for installing other software rather
than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to
the micro-controller on our board). The IC used named as ATmega328 on the Arduino
Nano comes pre burned with a boot loader that allows us to upload new code to it without
the use of an external hardware programmer.Communication is using the original STK500
protocol (reference, C header files). We can also bypass the boot loader and programs the
micro-controller through the ICSP (In Circuit Serial Programming) header. The
ATmegal6U2 (or 8U2 in the revl and rev2 boards) firmware source code is available.
The ATmegal6U2/8U2 is loaded with a DFU boot loader, which can be activated by:

On Rev1l boards: connecting the solder jumper on the back of the board (near the map of
Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling
the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode.

The Arduino Nano is one of the latest digital micro-controller units and has a number of
facilities for communicating with a computer, another Arduino, or other micro-controllers.
The ATmega328 provides UART TTL at (5V) with serial communication, which is
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available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the
data. An ATmegal6U2 on the board channels this serial communication over USB and
appears as a virtual com port to software on the computer. The '16U2 firmware uses the
standard USB COM drivers, and no external driver is needed. However, on Windows, an
in file is required. The Arduino software includes a serial monitor which allows simple

textual data to be sent to and from the Arduino board.

The RX and TX LEDs on the board will flash when data is being transmitted via the USB-
to-serial chip and USB connection to the computer (but not for serial Communication on
pins 0 and 1). A Software Serial library allows for serial communication on any of the
Nano's digital pins. The ATmega328 also supports 12C (TWI) and SPI communication.
The Arduino software includes a Wire library to simplify use of the 12C bus. Arduino
programs are written in C or C++ and the program code written for Arduino is called
sketch. The Arduino IDE uses the GNU tool chain and AVR Lab to compile programs,
and for uploading the programs it uses argued. As the Arduino platform uses Atmel
micro-controllers, Atmel's development environment, AVR Studio or the newer Atmel

Studio, may also be used to develop software for the Arduino.

€9 sketch_sepl4a | Arduino 1.6.11 (Windows Store 1.6.11.0) - m] X
File Edit Sketch Tools Help

sketch_sepi1da

roid setup() {

// put your set

Figure 3.16: Arduino Software Interface IDE
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The Arduino Integrated Development Environment - or Arduino Software (IDE) -
contains a text editor for writing code, a message area, a text console, a toolbar with
buttons for common functions and a series of menus. It connects to the Arduino and

Genuino hardware to upload programs and communicate with them.

Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are
written in the text editor and are saved with the file extension .ino. The editor has features
for cutting/pasting and for searching/replacing text. The message area gives feedback
while saving and exporting and also displays errors. The console displays text output by
the Arduino Software (IDE), including complete error messages and other information.
The bottom righthand corner of the window displays the configured board and serial port.
The toolbar buttons allow you to verify and upload programs, create, open, and save

sketches, and pen the serial monitor.

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store
your programs (or sketches). The sketches in your sketchbook can be opened from the File
> Sketchbook menu or from the Open button on the toolbar. The first time you run the
Arduino software, it will automatically create a directory for your sketchbook. You can
view or change the location of the sketchbook location from with the Preferences
dialog.Beginning with version 1.0, files are saved with a .ino file extension. Previous
versions use the .pde extension. You may still open .pde named files in version 1.0 and

later, the software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation

Allows you to manage sketches with more than one file (each of which appears in its own
tab). These can be normal Arduino code files (no visible extension), C files (.c extension),
C++ files (.cpp),or header files (.h)UploadingBefore uploading your sketch, you need to
select the correct items from the Tools > Board and Tools > Port menus. The boards are
described below. On the Mac, the serial port is probably something like
/dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or /dev/ity.usbserial-1B1
(for a Duemilanove or earlier USB board), or /Mdev/tty. USA19QW1b1P1.1 (for a serial
board connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably



COML1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB
board) - to find out, you look for USB serial device in the ports section of the Windows
Device Manager. On Linux, it should be /dev/ttyACMx , /dev/ttyUSBx or similar. Once
you've selected the correct serial port and board, press the upload button in the toolbar or
select the Upload item from the Sketch menu. Current Arduino boards will reset
automatically and begin the upload. With older boards (pre-Diecimila) that lack auto-
reset, you'll need to press the reset button on the board just before starting the upload. On
most boards, you'll see the RX and TX LEDs blink as the sketch is uploaded. The Arduino
Software (IDE) will display a message when the upload is complete, or show an
error.When you upload a sketch, you're using the Arduino boot loader, a small program
that has been loaded on to the micro-controller on your board. It allows you to upload
code without using any additional hardware. The boot loader is active for a few seconds
when the board resets; then it starts whichever sketch was most recently uploaded to the
micro-controller. The boot loader will blink the on-board (pin 13) LED when it starts (i.e.

when the board resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or
manipulating data. To use a library in a sketch, select it from the Sketch > Import Library
menu. This will insert one or more #include statements at the top of the sketch and
compile the library with your sketch. Because libraries are uploaded to the board with
your sketch, they increase the amount of space it takes up. If a sketch no longer needs a
library, simply delete its #include statements from the top of your code.There is a list of
libraries in the reference. Some libraries are included with the Arduino software. Others
can be downloaded from a variety of sources or through the Library Manager. Starting
with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in an

open sketch. See these instructions for installing a third-party library.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your
sketchbook directory. Platforms installed there may include board definitions (which
appear in the board menu), core libraries, bootloaders, and programmer definitions. To
install, create the hardware directory, then unzip the third-party platform into its own sub-
directory. (Don't use "arduino™ as the sub-directory name or you'll override the built-in
Arduino platform.) To uninstall, simply delete its directory.



For details on creating packages for third-party hardware, see the Arduino IDE 1.5 3rd

party Hardware specification.

Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial connector.
To send data to the board, enter text and click on the "send" button or press enter. Choose
the baud rate from the drop-down menu that matches the rate passed to Serial.begin in
your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your
sketch) when you connect with the serial monitor. Please note that the Serial Monitor does
not process control characters; if your sketch needs a complete management of the serial
communication with control characters, you can use an external terminal program and

connect it to the COM port assigned to your Arduino board.

3.9EasyEDA

EasyEDA is a web-based EDA tool suite that enables hardware engineers to design,
simulate, share-publicly and privately-and discuss schematics, simulations and printed
circuit boards. Other features include the creation of a bill of materials, Gerber files and
pick and place files and documentary outputs in PDF, PNG and SVG formats.EasyEDA
allows the creation and editing of schematic diagrams, SPICE simulation of mixed
analogue and digital circuits and the creation and editing of printed circuit board layouts

and, optionally, the manufacture of printed circuit boards.

Subscription-free membership is offered for public plus a limited number of private
projects. The number of private projects can be increased by contributing high quality
public projects, schematic symbols, and PCB footprints and/or by paying a monthly
subscription.Registered users can download Gerber files from the tool free of charge; but
for a fee, EasyEDA offers a PCB fabrication service. This service is also able to accept

Gerber file inputs from third party tools.
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Figure 3.17: EasyEDA Software Interface
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CHAPTER 4
METHODOLOGY

4.1 Working Principle

Connecting with the controller here is AC 220 volts coming to the circuit by converting to
5volts DC via SMPS. Which is safe for our project equipment. This project we use
Arduino Nanomicro-controller for controlling this project. Here also use a Temperature
sensor, Pump Motor, Engine Box used a Light.The system will work if our project is
connected to power and switched on. At this moment,temperature rises above 35 degrees,
then a Pump Motor will be turned on through the micro-controller relay.If the temperature
inside the Engine Box is less than 25 degrees then a Pump Motor will be turned off. A
temperature sensor has been installed here to measure the temperature. This will help the

temperature of the engine to return to normal. This is the main purpose of our project.

4.2 Block Diagram

The block diagram here is representing the whole circuit and the components of the

project. Here we have used standardized symbols and lines.

220V AC » SMPS #] DC Output

Temperature -
Sl:usar I .—\rfluino Pump
Nano - Relay ‘ Motor

Figure 4.1: Block Diagram of Our Project



4.3 Schematic Diagram

The schematic diagram here is representing the electrical circuit and the components of

the project. Here we have used standardized symbols and lines.
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Figure 4.2: Schematic Diagram of Project
4.4 Final Project View

Here we have shown the final project overview with appropriate marking.

Figure 4.3: Final Project Vi



CHAPTER 5
RESULT AND DISCUSSION

5.1 Result

After making our project we observe it very careful. It works as we desire. Our project
give output perfectly and all equipment are work perfectly. We check how much it works

and we get perfect output from this project.

® Firstly, when we press switch on then the project will be run,

® After that temperature rises above 35 degrees, then a Pump Motor will be turned on
through the micro-controller relay.

® Then when the temperature inside the Engine Box is less than 25 degrees then a Pump
Motor will be turned off.

® Then the temperature sensor has been installed here to measure the temperature. This

will help the temperature of the engine to return to normal.

5.2 Discussion

Engine cooling is crucial for maintaining the optimal operating temperature of the engine.
Excessive heat can lead to various issues such as reduced efficiency, increased wear and
tear, and potential engine damage. A well-designed cooling system helps dissipate heat
efficiently, ensuring the engine operates within the desired temperature range.The
efficiency of a cooling system depends on several factors, including the radiator's size,
airflow through the radiator, coolant flow rate, and the effectiveness of heat transfer.
Designing an efficient cooling system requires careful consideration of these factors to

ensure adequate cooling capacity under different operating conditions.

5.3 Advantages

There are Some advantages of our Project because of its accuracy. The advantages are

pointed out below:

® Temperature Regulation: The primary advantage of a water cooling system is its

ability to regulate the engine's temperature effectively.



® Efficient Heat Dissipation: Water cooling systems are highly efficient at dissipating
heat compared to air cooling systems.

® Engine Longevity: By maintaining the engine within its optimal temperature range, a
water cooling system contributes to the longevity of the engine.
Maintenance cost is very less.

Simple construction.

5.4Disadvantages

There are SomeDisadvantages of our Project because of its accuracy. The Disadvantages

are pointed out below:

® High Initial Cost.
® Limited Efficiency at Low Speeds.

® Maintenance Requirements.

5.5 Applications

The application areas for Our Project in this modern and practical world are huge and

some of these are given below:

Passenger Cars
Trucks and Commercial Vehicles
Motorcycles

Performance and Sports Cars.

Industrial and Power Generation Equipment.
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CHAPTER 6
CONCLUSION

6.1 Conclusion

In conclusion, automotive water cooling systems play a vital role in maintaining the
optimal operating temperature of internal combustion engines. They offer several
advantages, including effective heat dissipation, temperature regulation, consistent
performance, and engine longevity. These systems are capable of handling the heat
generated by engines of different sizes and power outputs, making them suitable for a wide
range of applications such as passenger cars, trucks, motorcycles, off-road vehicles,
performance cars, motorhomes, and industrial equipment.While water cooling systems
have some potential disadvantages, such as complexity, maintenance requirements, and the
risk of coolant leaks, these can be mitigated with proper maintenance and care. Overall,
water cooling systems remain the preferred choice in automotive applications due to their
superior cooling capabilities and the ability to handle demanding conditions.As technology
continues to advance, we can expect further improvements in water cooling system design,
efficiency, and integration with other vehicle systems. These advancements will contribute
to more reliable and efficient engine cooling, enhancing overall vehicle performance and

reliability.

6.2 Future Scope

As we have already discussed about the limitations of this system so definitely there’s
room for improvement and thus we have Some future scope of work available to us for

this system. Some of these are listed below:

» Intelligent Cooling System Control: The integration of smart sensors, actuators,
and control systems can enable more precise and adaptive control of the cooling
system.

» Alternative Cooling Technologies: While water cooling systems are widely used,

there is ongoing research into alternative cooling technologies.
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APPENDIX

Micro-controller Code:

#include <LiquidCrystal_12C.h>
LiquidCrystal_12C lcd(0x3F, 16, 2); // 12C address 0x3F, 16 column and 2 rows 270r3F

#include "DHT.h"

#define DHTPIN 4

#define DHTTYPE DHT11

int light=10;

int pump=11;

DHT dht(DHTPIN, DHTTYPE);

void setup()

{
Serial.begin(9600);
pinMode(light, ODUTPUT);
pinMode(pump,OUTPUT);

dht.begin(); // initialize the sensor
Icd.init();  // initialize the lcd
Icd.backlight(); // open the backlight

void loop()
{

delay(2000); // wait a few seconds between measurements

float humi = dht.readHumidity(); // read humidity

float tempC = dht.read Temperature(); // read temperature



Icd.clear();

Il check if any reads failed

if (isnan(humi) || isnan(tempC)) {
Icd.setCursor(0, 0);
Icd.print("Failed");

}else {
Icd.setCursor(0, 0); // start to print at the first row
lcd.print("Temp: *);
Icd.print(tempC);  // print the temperature
Icd.print((char)223); // print ° character
Icd.print("C™);
Serial.print("'temp");
Serial.printin(tempC);

Icd.setCursor(0, 1); // start to print at the second row
Icd.print("Humi: ");

lcd.print(humi);  // print the humidity
Icd.print("%");

Serial.print("humi");

Serial.printin(humi);

if(tempC>35 }{
digitalWrite(pump,HIGH);
digitalWrite(light, LOW);
Icd.setCursor(0, 1); // start to print at the second row
Icd.print("Tempareture High ™);

}



if(tempC>35 && tempC>33 K
digitalWrite(pump,HIGH);
digitalWrite(light, LOW);
Icd.setCursor(0, 1); // start to print at the second row
lcd.print("Tempareture High ™);
}
if(tempC<33){
digitalWrite(pump,LOW);
digitalWrite(light, HIGH);
}
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